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概要

本書は、Red Hat Decision Manager 7.4 にアドオンとして含まれている OptaShift Employee
Rostering テンプレートを実行し、変更する方法を説明します。
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はじめに

ビジネスルールの作成者は、IDE を使用して Red Hat Business Optimizer 機能を使用する employee-
rostering スターターアプリケーションのビルド、実行、変更が可能です。

前提条件

Eclipse (Red Hat Developer Studio を含む) または IntelliJ IDEA などの統合開発環境を使用する
こと。

Java 言語を理解していること。

はじめに
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第1章 従業員勤務表スターターアプリケーションの概要
従業員勤務表スターターアプリケーションは、組織内のさまざまな場所に従業員を割り当てます。たと
えば、アプリケーションを使用して、病院での看護師のシフト、さまざまな場所での警備勤務シフト、
作業者の組み立てラインのシフトを割り当てます。

従業員勤務表を最適化するには、多くの変数を考慮する必要があります。たとえば、業務が異なれば、
求められるスキルが異なります。また、従業員の中には、特定の時間帯に勤務できない場合や、特定の
時間帯での勤務を希望する場合があります。さらに、従業員によっては、1 回に就業できる時間に制限
がある契約を交わしている可能性があります。

このスターターアプリケーションの Red Hat Business Optimizer ルールは、ハード制約およびソフト制
約を使用します。最適化時に、従業員が勤務できない (または病欠の) 場合や、ある 1 つのシフト内の 2
つのスポットで働くことができない場合など、プランニングエンジンはハード制約に違反することがで
きません。プランニングエンジンは、ソフト制約 (特定のシフトで勤務しないという従業員の希望など)
に順守しようとしますが、最適なソリューションには違反が必要だと判断した場合は、違反することが
できます。
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第2章 従業員勤務表スターターアプリケーションの構築と実行
ソースコードから従業員勤務表スターターアプリケーションを構築して、JBoss EAP または WildFly ア
プリケーションサーバーを使用して実行します。

コマンドラインを使用してアプリケーションを構築してから、スタンドアロンサーバーにインストール
します。

または、Eclipse (Red Hat JBoss Developer Studio を含む) などの IDE を使用して、アプリケーション
を構築し、実行します。

また、ソースコードで提供されるビルド済みの WAR ファイルをデプロイして実行します。

このアプリケーションの使用に関する情報は、Red Hat OpenShift Container Platform での Red Hat
Business Optimizer 向け従業員勤務表スターターアプリケーションのデプロイと使用を参照してくださ
い。

2.1. デプロイメントファイルの準備

デプロイメントファイルをダウンロードし、準備してから、アプリケーションの構築、デプロイを行う
必要があります。

手順

1. Red Hat Decision Manager 7.4 の Software Downloads ページから rhdm-7.4.0-add-ons.zip
ファイルをダウンロードします。

2. ダウンロードしたアーカイブを展開します。

3. アドオンアーカイブから展開した rhdm-7.4.0-employee-rostering.zip ファイルを展開しま
す。
employee-rostering-distribution-7.23.0.Final-redhat-00002 ディレクトリーが作成されます。
このディレクトリーは、後述する例でベースとなるディレクトリーです。

注記

ファイルおよびディレクトリーの名前で使用されるバージョン番号は、本書で使
用するバージョンよりも新しい場合があります。

2.2. コマンドラインからの従業員勤務表スターターアプリケーションの構築
と実行

コマンドラインを使用して、従業員勤務表スターターアプリケーションを構築し、実行することができ
ます。

この手順を使用する場合は、データはメモリーに保存されるため、サーバーが停止するとデータが失わ
れます。データベースサーバーを使用してアプリケーションを構築し、実行して永続的に保存する方法
は、「コマンドラインからの永続データストレージを使用した従業員勤務表スターターアプリケーショ
ンの構築と実行」 を参照してください。

前提条件

「デプロイメントファイルの準備」 の説明に従ってデプロイメントファイルを準備しておく。

第2章 従業員勤務表スターターアプリケーションの構築と実行
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Java 開発キットがインストールされている。

Maven がインストールされている。

ホストからインターネットにアクセスできる。ビルドプロセスは、インターネットを使用し
て、外部のリポジトリーから Maven パッケージをダウンロードします。

手順

1. ターミナルウィンドウで、sources ディレクトリーに移動します。

2. 次のコマンドを実行します。

3. ビルドプロセスが完了するまで待ちます。

4. 以下のいずれかの方法を使用して、アプリケーションを実行します。

a. ビルドプロセスの一部としてデプロイされた WildFly サーバーを実行します。

i. local/appserver/wildfly-14.0.1-final/standalone/deployments サブディレクトリー
で、optaweb-employee-rostering-webapp-<version>.war.dodeploy ファイルを作成
します。<version> は、同じディレクトリーにある既存の optaweb-employee-
rostering-webapp-<version>.war シンボリックリンクと同じでなければなりません。

ii. local/appserver/wildfly-14.0.1-final/bin サブディレクトリーで ./standalone.sh コマン
ドを実行します。

b. 既存の WildFly または JBoss EAP サーバーに optaweb-employee-rostering-
webapp/target/optaweb-employee-rostering-*.war ファイルをデプロイして、アプリケー
ションサーバーを起動します。

c. 以下のコマンドで、Maven を使用してサーバーを実行します。

注記

Maven を使用してサーバーを起動した場合には、UI は gwt コードサーバー
を使用して gwtui ソースを監視します。このような場合には、gwtui コード
を変更すると、コードサーバーで自動的に変更を検出します。gwtui コード
の変更には、アプリケーションの再構築は必要ありません。

後ほど、このサーバーを停止するには、以下のコマンドを使用します。

5. アプリケーションにアクセスするには、Web ブラウザーに
http://localhost:8080/gwtui/gwtui.html を入力します。

2.3. コマンドラインからの永続データストレージを使用した従業員勤務表ス

mvn clean install -DskipTests

mvn -N wildfly:start wildfly:deploy
mvn gwt:codeserver

mvn -N wildfly:shutdown

Red Hat Decision Manager 7.4 IDE を使用した Red Hat Business Optimizer 向け従業員勤務表スターターアプリケーションの実行および変更
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2.3. コマンドラインからの永続データストレージを使用した従業員勤務表ス
ターターアプリケーションの構築と実行

コマンドラインで従業員勤務表スターターアプリケーションを構築し、実行する場合には、データベー
スサーバーを指定して、永続的にデータを保存することができます。

前提条件

「デプロイメントファイルの準備」 の説明に従ってデプロイメントファイルを準備しておく。

Java 開発キットがインストールされている。

Maven がインストールされている。

ホストからインターネットにアクセスできる。ビルドプロセスは、インターネットを使用し
て、外部のリポジトリーから Maven パッケージをダウンロードします。

WildFly または Red Hat JBoss EAP アプリケーションサーバーと、MySQL または PostrgeSQL
データベースサーバーをデプロイしておく。

データベースサーバー用に、アプリケーションサーバーで JDBC データソースを設定してお
く。

手順

1. ターミナルウィンドウで、sources ディレクトリーに移動します。

2. 次のコマンドを実行します。

上記のコマンドでは、以下の値に置き換えてください。

<dsname> は、アプリケーションサーバーのデータソース名に置き換えます。

<dialect> は、データベースサーバーの種類によって以下の文字列のいずれかに置き換えま
す。

MySQL の場合は org.hibernate.dialect.MySQL5Dialect を使用します。

PostgreSQL の場合は org.hibernate.dialect.PostgreSQLDialect を使用します。

3. ビルドプロセスが完了するまで待ちます。

4. optaweb-employee-rostering-webapp/target/optaweb-employee-rostering-7.23.0.Final-
redhat-00002.war ディレクトリーをアプリケーションサーバーにデプロイして、アプリケー
ションサーバーを起動します。

5. アプリケーションにアクセスするには、Web ブラウザーに
http://localhost:8080/gwtui/gwtui.html を入力します。

2.4. ECLIPSE を使用した従業員勤務表スターターアプリケーションの構築
と実行

Red Hat JBoss Development Studio を含む Eclipse を使用して、従業員勤務表スターターアプリケー

mvn clean install -Dproductized -Dorg.optaweb.employeerostering.persistence.datasource=
<dsname> -Dorg.optaweb.employeerostering.persistence.dialect=<dialect>

第2章 従業員勤務表スターターアプリケーションの構築と実行
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Red Hat JBoss Development Studio を含む Eclipse を使用して、従業員勤務表スターターアプリケー
ションを構築して実行できます。

前提条件

「デプロイメントファイルの準備」 の説明に従ってデプロイメントファイルを準備しておく。

Eclipse がインストールされている。

ホストからインターネットにアクセスできる。ビルドプロセスは、インターネットを使用し
て、外部のリポジトリーから Maven パッケージをダウンロードします。

Google Chrome がインストールされている。これは、推奨の設定でアプリケーションを実行す
るためです。

注記

別の Web ブラウザーを使用するように設定を変更できます。

手順

1. Eclipse を起動します。

2. メインメニューから File > Import…​ を選択します。

3. Maven > Existing Maven projects ウィザードを選択します。

4. root ディレクトリーでは、アプリケーションソースの root ディレクトリーを選択します。

5. Finish をクリックします。

6. オプションで、Eclipse で多くのエラーが表示されるのを回避するには、以下を行います。

a. アプリケーションソースの root ディレクトリーで、mvn clean install コマンドを実行し
て、ビルドが完了するのを待ちます。

b. Eclipse ナビゲーションツリーで、employee-rostering-shared を右クリックして、Build
Path > Configure Build Path…​ を選択します。

c. Source タブをクリックしてから、Add Folder…​ をクリックします。

d. employee-rostering-shared/target/generated-sources フォルダーをクリックして、OK
をクリックします。

7. メインメニューから Run > External Tools > External Tools Configurations…​ を選択します。

8. Program で以下の起動設定を作成します。

a. Chrome で OptaWeb 従業員勤務表を開く設定:

名前: Open OptaWeb Employee Rostering in Chrome

場所: /usr/bin/google-chrome

作業ディレクトリー: ${workspace_loc:/employee-rostering}

引数: --incognito http://localhost:8080/gwtui/gwtui.html

注記

Red Hat Decision Manager 7.4 IDE を使用した Red Hat Business Optimizer 向け従業員勤務表スターターアプリケーションの実行および変更
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注記

Chrome の代わりに別のブラウザーを使用する場合には、名前、場所、
引数を変更できます。

b. コードサーバーを終了する設定:

名前: Kill Code Server

場所: /usr/sbin/fuser

作業ディレクトリー: ${workspace_loc:/employee-rostering}

引数: fuser -k 9876/tcp

9. メインメニューから Run > Run Configurations…​ を選択します。

10. Maven Build で以下の起動設定を作成します。

a. OptaWeb 従業員勤務表のビルド:

名前: OptaWeb Employee Rostering Build

ベースのディレクトリー: ${workspace_loc:/employee-rostering}

目標: clean install

パラメーター: gwt:skipCompilation 値: true

b. OptaWeb 従業員勤務表の起動コードサーバー:

名前: OptaWeb Employee Rostering Start Code Server

ベースのディレクトリー: ${workspace_loc:/employee-rostering}

目標: gwt:codeserver

パラメーター: gwt:skipCompilation 値: true

c. OptaWeb 従業員勤務表の起動の Webserver:

名前: OptaWeb Employee Rostering Start Webserver

ベースのディレクトリー: ${workspace_loc:/employee-rostering}

目標: wildfly:start wildfly:deploy

パラメーター: gwt:skipCompilation 値: true

d. OptaWeb Employee Rostering の停止の Webserver:

名前: OptaWeb Employee Rostering Stop Webserver

ベースのディレクトリー: ${workspace_loc:/employee-rostering}

目標: wildfly:shutdown

パラメーター: gwt:skipCompilation 値: true

第2章 従業員勤務表スターターアプリケーションの構築と実行
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11. Launch Group の下に、OptaWeb Employee Rostering Run という名前の起動グループを作成
します。それに次のローンチを追加します。

Program::Kill Code Server 起動モード: 継承 起動後のアクション: 中断されるまで待機

Maven Build::OptaWeb Employee Rostering Stop Webserver 起動モード: 継承 起動後の
アクション: 中断されるまで待機

Maven Build::OptaWeb Employee Rostering Build 起動モード: 継承 起動後のアクション:
中断されるまで待機

Maven Build::OptaWeb Employee Rostering Start Webserver 起動モード: 継承 起動後の
アクション: なし

Maven Build::OptaWeb Employee Rostering Start Code server 起動モード: 継承 起動後
のアクション: コンソールの出力を待つ (regexp): The code server is ready at

Program::Open OptaWeb Employee Rostering in Chrome 起動モード: 継承 起動後のア
クション: なし

12. アプリケーションをビルドして実行し、すぐにアクセスするには、OptaWeb Employee 
Rostering Run 起動グループを実行します。次にアプリケーションを変更して、起動グループ
に戻り、変更をテストします。

注記

この方法を使用してアプリケーションを起動した場合には、UI は gwt コード
サーバーを使用して gwtui ソースを監視します。gwtui コードを変更すると、
コードサーバーで自動的に変更を検出します。gwtui コードの変更には、アプリ
ケーションの再構築は必要ありません。

2.5. 同梱のビルド済み WAR ファイルの実行

Employee Rostering スターターアプリケーションにアクセスするには、Red Hat Decision Manager に
同梱されている、ビルド済みの employee-rostering-webapp-7.23.0.Final-redhat-00002.war ファイル
をデプロイして実行します。

前提条件

「デプロイメントファイルの準備」 の説明に従ってデプロイメントファイルを準備しておく。

Java 開発キットがインストールされている。

WildFly または Red Hat JBoss EAP アプリケーションサーバーがデプロイされている。

手順

1. WildFly または Red Hat JBoss EAP アプリケーションサーバーで、プロパティーの置換を有効
にします。Red Hat JBoss EAP でのプロパティー置換の有効化と無効化の詳細については、プ
ロパティーの置換を参照してください。

a. スタンドアロンモードでアプリケーションサーバーを起動します。

b. 次のコマンドを入力して、管理 CLI を起動します。

EAP_HOME/bin/jboss-cli.sh --connect
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c. 管理 CLI で、次のコマンドを入力します。

/subsystem=ee:write-attribute(name="spec-descriptor-property-replacement",value=true)

2. アプリケーションサーバーを停止します。

3. binaries/employee-rostering-webapp-7.23.0.Final-redhat-00002.war ディレクトリーをアプ
リケーションサーバーにデプロイして、アプリケーションサーバーを起動します。

4. アプリケーションにアクセスするには、Web ブラウザーに
http://localhost:8080/gwtui/gwtui.html を入力します。
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第3章 従業員勤務表スターターアプリケーションのソースコードに
関する概要

従業員勤務表スターターアプリケーションは、以下の主要コンポーネントで設定されています。

Red Hat Business Optimizer を使用して勤務表のロジックを実装して、REST API を提供する
サーバー

gwt ライブラリーを使用してユーザーインターフェイスを実装し、REST API でサーバーを呼び
出す クライアント

クライアントとサーバーの間でコードを共有し、これらのコンポーネントを個別にビルドし使用するこ
とができます。特に、異なるユーザーインターフェイスを実装して、REST API でサーバーを呼び出す
ことができます。

主なコンポーネント 2 つに加え、従業員勤務表テンプレートには、ランダムなソースデータのジェネ
レーター (デモやテスト目的で便利) やベンチマークアプリケーションが含まれます。

モジュールおよび主要なクラス

従業員勤務表テンプレートの Java ソースコードには複数の Maven モジュールが含まれます。これらの
モジュールごとに、個別の Maven プロジェクトファイル (pom.xml) が含まれていますが、これは共通
のプロジェクトで構築するために設計されています。

モジュールには、Java クラスなど複数のファイルが含まれます。このドキュメントでは、全モジュー
ルと、従業員勤務表計算の主な情報を含むその他のファイルとクラスをリストします。

employee-rostering-benchmark モジュール: 乱数データを生成し、ソリューションをベンチ
マーク化する追加のアプリケーションが含まれます。

employee-rostering-distribution モジュール: readme ファイルが含まれます。

employee-rostering-docs モジュール: ドキュメントファイルが含まれます。

employee-rostering-gwtui モジュール: gwt ツールキットを使用して開発したユーザーイン
ターフェイスを使用するクライアントアプリケーションが含まれます。

employee-rostering-server モジュール: Red Hat Business Optimizer を使用して勤務表の計算
を行うサーバーをアプリケーションが含まれます。

src/main/resources/org/optaweb/employeerostering/server/solver/employeeRostering
ScoreRules.drl ファイル: Red Hat Business Optimizer の計算用のルールが含まれます。こ
れらのルールは、Drools ルール言語で記述されています。ルールを修正して、従業員勤務
表のロジックを変更できます。

src/main/java/org.optaweb.employeerostering.server.roster/rosterGenerator.java クラ
ス: デモおよびテスト目的でランダムな入力データを生成します。必要な入力データを変更
する場合には、生成器も合わせて変更してください。

employee-rostering-shared モジュール: サーバーとクライアントアプリケーション間で共有さ
れるデータ構造が含まれます。特
に、src/main/java/org/optaweb/employeerostering/shared/* では、このモジュールには以下
のクラスを含む勤務表計算の入力データを定義する Java クラスが含まれます。

employee/EmployeeAvailability.java は、従業員の空き情報を定義します。時間枠ごと
に、従業員の空き状況と、従業員の希望する時間枠を指定できます。

employee/Employee.java は従業員を定義します。従業員には名前とスキル一覧があり、

Red Hat Decision Manager 7.4 IDE を使用した Red Hat Business Optimizer 向け従業員勤務表スターターアプリケーションの実行および変更

12



employee/Employee.java は従業員を定義します。従業員には名前とスキル一覧があり、
契約に従って仕事に従事します。スキルは、EmployeeSkillProficiency オブジェクトで表
現します。

roster/Roster.java は計算した勤務表情報を定義します。

shift/Shift.java は、従業員を割り当て可能なシフトを定義します。シフトは、時間枠とス
ポットで定義します。たとえば、レストランでは、Kitchen のスポットで、February 20 
8AM-4PM の時間枠のシフトなどがあります。複数のシフトを、特定のスポットと時間枠に
定義できます。今回の例では、このスポットと時間枠には複数の従業員が必要です。

skill/Skill.java は、従業員が持つスキルを定義します。

spot/Spot.java は、従業員を配置可能なスポットを定義します。たとえば、レストランで
は Kitchen をスポットとして指定できます。

contract/Contract.java は、さまざまな期間の従業員の労働時間を制限する契約を定義しま
す。

tenant/Tenant.java はテナントを定義します。テナントごとに、独立したデータセットを
表します。あるテナントのデータが変更されても、他のテナントには影響がありません。
employee-rostering-shared モジュールにも、他の共有アーティファクトが含まれます。

*View.java クラスは、他の情報から計算する値のセットを定義します。クライアントアプ
リケーションは、REST API 経由でこれらの値を読み取りますが、書き込みはできません。

*RestService.java インターフェイスは REST API を定義します。サーバーとクライアント
アプリケーションのいずれも、これらのインターフェイスの実装を個別に定義します。

employee-rostering-shared-gwt モジュール: GWT クライアントアプリケーションに必要なク
ラスが含まれます。

employee-rostering-webapp モジュール: アプリケーション全体 (クライアントとサーバー) の
ビルドに必要な HTML と他のファイルが含まれます。
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第4章 従業員勤務表スターターアプリケーションの変更
従業員勤務表スターターアプリケーションをニーズに合わせて変更するには、最適化プロセスを統括す
るルールを変更する必要があります。また、データ構造に必要なデータを含み、ルールに必要な計算が
提供されるようにする必要があります。必要なデータがユーザーインターフェイスに存在しない場合
は、ユーザーインターフェイスも変更する必要があります。

以下の手順では、従業員勤務表スターターアプリケーションの変更に関する一般的なアプローチを説明
しています。

前提条件

アプリケーションを正常にビルドするビルド環境がある。

Java コードの読み取りと変更ができる。

手順

1. 必要な変更をプランニングします。以下の質問に答えてください。

回避する 必要 がある追加のシナリオは何ですか。これらのシナリオは ハード制約 です。

可能な場合は、Optimizer が 回避しなければ ならない追加のシナリオは何ですか。これら
のシナリオは ソフト制約 です。

それぞれのシナリオがソリューションで実行されるかどうかを計算するのに必要なデータ
は何ですか。

既存のバージョンで入力した情報から取得可能なデータはどれですか。

ハードコードが可能なデータはどれですか。

ユーザー入力が必要なデータと、現在のバージョンで入力されていないデータはどれです
か。

2. 必須データを現在のデータから計算するか、ハードコード化できる場合は、計算か、ハード
コードを既存のビューまたはユーティリティークラスに追加します。データをサーバー側で計
算する必要がある場合は、REST API エンドポイントを追加して読み込みます。

3. ユーザーが必須データを入力する必要がある場合は、データのエントリーを表現するクラスに
そのデータを追加 (例: Employee クラス) し、データの読み取り、および書き込み用に REST
API エンドポイントを追加して、データ入力用にユーザーインターフェイスを変更してくださ
い。

4. 全データが利用できる場合は、ルールを変更します。変更の大半は、新規ルールを追加する必
要があります。これらのルールは、employee-rostering-server モジュールの 
src/main/resources/org/optaweb/employeerostering/server/solver/employeeRosteringSco
reRules.drl ファイルに配置されます。
ルールには、Drools 言語を使用します。Drools ルール言語に関する参考情報は、Rule
Language Referenceを参照してください。optaweb-employee-rostering-shared と optaweb-
employee-rostering-server モジュールで定義されるクラスは、デシジョンエンジンで利用で
きます。

5. アプリケーションの変更後に、ビルドして実行します。
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